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WLC1150 MP-A2 50-W wireless power 

transmitter (REF_WLC_TX50W_N1) user guide 

About this document 

Scope and purpose 

This document is a user guide for the WLC1150 MP-A2 50-W wireless power transmitter reference solution 

(REF_WLC_TX50W_N1). It supports high-power proprietary protocol up to 50-W charging with the Infineon 50 W 

Rx board (REF_WLC_RX50W_N1) and is compatible with the Qi EPP 15 W protocol. The reference board 

demonstrates the capabilities and features of the Infineon WLC1150 wireless charging transmitter controller. 

WLC1150 is a highly integrated wireless power transmitter with an integrated USB Type-C Power Delivery (PD) 

controller, compliant with the USB PD 3.1 specification. 

You can see the relevant sections based on your requirement: 

• Introduction – Provides basic information on the reference board, including details about the interfaces. 

• WLC1150 software tool – Provides an overview of the Wireless Charging Configuration Utility software. 

• WLC1150 wireless power transmitter system design – Explains the reference board architecture and 

system design details. 

• Reference board operation – Describes operating the reference board as a wireless power transmitter, 

configuring the system-level parameters, downloading the firmware, and capturing the debug log.  

Intended audience 

The document is intended for the users of the WLC1150 50-W wireless power transmitter reference board 

(REF_WLC_TX50W_N1). 
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Safety information 

The REF_WLC_TX50W_N1 reference board is intended for use as an evaluation platform for hardware or 

software in a laboratory environment. The board is an open-system design, which does not include a shielded 

enclosure. Because of this reason, the board may cause interference with other electrical or electronic devices 

in close proximity. In such cases, take adequate preventive measures. Also, do not use this board near any 

medical equipment or RF devices.  

Attaching additional wiring to this product or modifying the product operation from the factory default may 

affect its performance and cause interference with other apparatus in the immediate vicinity. If such 

interference is detected, suitable mitigating measures must be taken. 

 

The REF_WLC_TX50W_N1 reference board contains ESD-sensitive devices. 

Electrostatic charges readily accumulate on the human body and any equipment, 

which can cause a discharge without detection. Permanent damage may occur to 

devices subjected to high-energy discharges. Proper ESD precautions are 

recommended to avoid performance degradation or loss of functionality. Store 

unused REF_WLC_TX50W_N1 reference boards in the protective shipping package. 

General safety instructions 

ESD protection  

ESD can damage boards and associated components. Infineon recommends that the user perform procedures 

only at an ESD workstation. If an ESD workstation is unavailable, use appropriate ESD protection by wearing an 

antistatic wrist strap attached to the chassis ground (any unpainted metal surface) on the board when handling 

parts. 

Handling boards 

The boards provided with the REF_WLC_TX50W_N1 reference board are sensitive to ESD. When removed from 

the casing, this applies to the boards supplied with a plastic casing. Hold the boards only by the edges. Place it 

on a grounded, static-free surface after removing a board from the box/casing. Use a conductive foam pad, if 

available. Do not slide the board over any surface. 
 

Do’s and don’ts 

 

 

 

• Do not touch the inverter output area marked below while the reference board is 

in use. The components in this area may operate at a voltage higher than 30 V. 

 

• Keep the coil area of the reference board clear from any metallic debris. 

• Monitor the coil interface’s surface temperature during prolonged usage. 
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• Ensure that there are no foreign metallic objects on the REF_WLC_TX50W_N1 

board’s charging interface surface soon after the phone/receiver is placed to avoid 

miscalibration and overheating. 

• Do not remove the fan connections anytime as it is required for cooling the 

receiver surface during high power transfer.  

• Ensure that the fan air inlet area located at bottom of the REF_WLC_TX50W_N1 

board is not blocked. 
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1 Introduction 

This document is a user guide for the WLC1150 MP-A2 50-W wireless power transmitter reference solution 

(REF_WLC_TX50W_N1). This solution consists of the reference board, firmware, and software utility called the 

Wireless Charging Configuration Utility.  

Infineon’s WLC1150-based 50-W wireless power transmitter reference board REF_WLC_TX50W_N1 is a highly 

integrated, Qi-compatible transmitter design with an MP-A2 type transmitter coil.  

The REF_WLC_TX50W_N1 board delivers a maximum output power of 50 W with the high-power Infineon 

Wireless Rx (REF_WLC_RX50W_N1) and 15 W maximum power with WPC-compliant wireless Rx. 

The REF_WLC_TX50W_N1 board works with high-power Infineon Wireless Rx (REF_WLC_RX50W_N1) by taking 

power from a Type-C PD adapter and delivering up to 50 W power. The input voltage will be automatically 

configured to 20 V. It can also be powered up with fixed input DC supply of 20 V/4 A. Input supply is used to 

power up the full-bridge inverter driving the resonance tank (resonance capacitor and transmitter coil). The 

inverter controls the output power flow by changing the switching frequency and duty. 

The REF_WLC_TX50W_N1 board also works with Qi-compliant wireless receivers by taking power from a Type-

C PD adapter and delivering up to 15 W power. The input voltage is automatically configured to 12 V or 15 V 

based on Type-C PPS/PD contract capability. Input supply is used to power up the full-bridge inverter driving 

the resonance tank (resonance capacitor and transmitter coil). The inverter controls the output power flow by 

varying the switching frequency and duty cycle. 

WLC1150 has integrated gate drivers for the buck and inverter power supplies necessary for wireless 

transmitter applications. Buck controller is being used to control the fan integrated with REF_WLC_TX50W. 

WLC1150 supports a wide input voltage range and offers many programmable features for creating distinct 

wireless transmitter solutions. 

The REF_WLC_TX50W_N1 is also compatible to charge iPhones, where the inverter operates at a fixed frequency 

of 127.7 kHz and 50% duty by taking power from a Type-C PPS adapter. It requires a Type-C PPS adapter. The 

input voltage supplied by the PPS adapter will be controlled by WLC1150, by input voltage configuration to 

control the output power flow. 

1.1 Contents 

The WLC1150 50-W wireless power transmitter reference board package contains the following: 

• REF_WLC_TX50W_N1 reference board  

• 65 W PPS compatible USB Type-C power adapter  

• USB Type-C cable  

• Infineon 50-W demo Rx board (REF_WLC_RX50W_N1)  

• HPI dongle (HPI_DONGLE) for programming/debugging  

• USB Micro-B cable  

• Jumper wires (x4)  

• Quick start guide  

The following items may be required for evaluating the wireless power transmitter capabilities of the reference 

board. Note that these are not included in the reference board package. 

• Qi- compliant phone 

• Windows PC running Windows OS 10 or higher to run the Wireless Charging Configuration Utility 

• DC power supply (Minimum 24 V, 4 A rated) 
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1.2 REF_WLC_TX50W_N1 release package 

Contact Infineon technical support to get the release package. The release package includes the following 

items: 

1.2.1 Documentation 

The documents include: 

• Quick start guide 

• Test report 

• User guide (this document) 

• WLC1150 datasheet 

• Release notes 

The hardware design files package includes: 

• Schematics 

• Bill of materials (BOM) 

• Layout files 

1.2.2 Downloading the kit document and hardware design file 

Download the documents and the hardware design files for REF_WLC_TX50W_N1 from the REF_WLC_TX50W_N1 

reference board webpage [1]. The documents include a quick start guide, test report, and user guide (this 

document). The hardware design files package includes a schematic, bill of materials (BOM), and layout files.  

1.2.3 Wireless Charging Configuration Utility 

Wireless Charging Configuration Utility supports the following key features: 

1. Downloading firmware onto the 50 W Tx reference board 

2. Configure the firmware parameters and download the updated configuration onto the 50 W Tx reference 

board 

3. Monitor and configure the firmware parameters dynamically while the 50 W Tx reference board is 

operational 

The REF_WLC_TX50W_N1 release package includes the installer for this utility. Install the utility on a Windows 

PC (Windows 10 or higher) and see the Utility user guide to get more details.  
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1.3 Board details 

The key interfaces of the WLC1150 50 W Tx reference board are marked in Figure 1. 
 

 

Figure 1 REF_WLC_TX50W_N1 board interfaces 
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2 WLC1150 software tool 

2.1 Wireless Charging Configuration Utility 

The WLC1150 controller is a fully programmable controller allowing users to configure the firmware parameters 

and store them in its internal flash memory. The Wireless Charging Configuration Utility is a Microsoft Windows 

application developed by Infineon to guide the WLC1150 user through the process of configuring and 

programming the WLC1150 device. The utility allows users to: 

1. To read the firmware configuration data from the REF_WLC_TX50W_N1 reference board and modify it or 

create a new configuration from the scratch. 

2. Program the resulting configuration data onto the target WLC1 device or program the complete firmware. 

3. Monitor and configure the firmware parameters dynamically while the 50 W Tx reference board is 

operational 

The WLC1150 controller supports programming over the CC and I2C interface. Usage of the Wireless Charging 

Configuration Utility requires the HPI dongle hardware, which is included in the reference design package.  
 

 

Figure 2 Wireless Charging Configuration Utility 
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3 WLC1150 wireless power transmitter system design 

The WLC1150 wireless transmitter implements 50-W wireless power transfer using the Infineon high-power 

protocol. The transmitter also supports BPP and EPP types of wireless receivers and is compliant with Qi 1.3.2 

specification.  

The interconnection of REF_WLC_TX50W_N1 with source and receivers is shown in Figure 3. The recommended 

DC input source configurations are listed in Table 1.  
 

 

Figure 3 WLC1150 kit interconnection 

 

Table 1 Input source for the reference board 

DC input source REF_WLC_TX50W_N1 requirement 

DC power supply DC voltage type  

24 V, 4 A output capacity 

USB Type-C and PD/PPS adapter 5 V, 3 A 

9 V, 3 A 

15 V, 3 A 

20 V, 3.25 A 

Note: The kit is configured to operate with 50 W Rx (REF_WLC_RX50W_N1) with USB PD input by default. 
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3.1 REF_WLC_TX50W_N1 MP-A2 50W power transmitter board 

The REF_WLC_TX50W_N1 MP-A2 50-W transmitter board implements the power stage and control of wireless 

power transfer system. The transmitter board architecture is shown in Figure 4.  
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Figure 4 REF_WLC_TX50W_N1 power transmitter reference board architecture 

The key features of the reference board are as follows: 

1. Qi 1.3.2 compatible 

2. Robust ASK and FSK in-band communication between transmitter and receiver 

3. Integrated foreign object detection based on system parameters such as Q-factor and power loss 

4. Type-C PD Input with PD compliance 

5. Wide input voltage ranges from 4.5 V to 24 V 

6. Integrated buck converter gate drive and control, operating at a switching frequency of 400 kHz 

7. Integrated gate drive for full-bridge inverter operating range of 110 kHz -145 kHz switching frequency 

8. MP-A2 coil with variable inverter frequency and duty control 

9. Peak efficiency of greater than 83% at full load of 15 W with WRM483265-10F5-12V-G 

10. Peak efficiency of greater than 89% at full load of 50 W with REF_WLC_RX50W board 

The reference board contains the following key sections: 

1. Input connector – The Tx board supports two sources of input power (USB PD and DC input) to support 

different use cases. The board can be powered using a USB-C power adapter over the USB Type-C connector 

(J1). There is also an option for a DC power supply connection (J3) to deliver power with a High Power 
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Infineon receiver board (REF_WLC_RX50W_N1). Note that at any point in time, only one input power source 

can be active. 

2. Fan regulator for powering the fan- The fan regulator is having buck converter stage to regulate VFAN 

voltage to 5 V for powering the fan.  

3. Fan for thermal management- The fan is operated for thermal management of the interface surface. It 

operates when power transfer by Tx is more than 40 W or Tx interface surface temperature is more than 

45°C, which is measured by NTC on the Tx board. The fan will turn off after the Tx- power falls below 35 W or 

coil temperature falls below 40°C. 

4. Inverter stage – The full-bridge inverter (Q4 to Q7) is operated at a frequency range of 110 kHz – 145 kHz to 

drive the resonant tank formed by the transmitter coil (Lr) and resonant capacitors (Cr). The coil voltage 

feedback (COIL-SNS) is used for Q-factor estimation and ASK demodulator circuits. 

5. Transmitter coil assembly – The transmitter coil is MP-A2 type with specifications per Qi standards. The 

coil is mounted on a separate coil PCB. A set of PCB shield (Shield PCB TOP and Shield PCB BOT) is mounted 

on top of the coil and an acrylic sheet form the interface surface of the transmitter. The coil mounting 

adhesive, spacers, and acrylic thickness are selected such that the distance between the coil top surface 

and to interface surface is approximately 3.1 mm (Qi specification: 3 mm + 0.5 mm/-0.25 mm). See Figure 5 

for coil assembly details. 
 

. dz
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PCB thickness –  .  mm
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Figure 5 MP-A2 transmitter coil assembly 

5. WLC1150-68LQXQ – The WLC1150 is a single controller unit to control the transmitter coil and USB PD 

interface. The WLC1150 simplifies the transmitter board architecture with inbuilt gate drivers for the 

auxiliary buck and inverter stage, inbuilt LDO for logic and core power, and more features. With an on-chip 

32-bit Arm® Cortex®-M0 processor, 128-KB flash, 16-KB RAM, and 32-KB ROM, the firmware supporting the 

complete high-power proprietary protocol and USB PD state machine logic can be programmed onto the 

WLC1150 controller. 

6. ASK demodulator – The ASK demodulator is based on coil voltage and bridge current. The demodulated 

signal from both paths is processed through a dual opamp-based gain stage and a comparator and decoded 

by the WLC1150 controller. 

7. Q-factor and resonance frequency estimation – The Q-factor estimation from coil voltage is performed by 

WLC1150 through the signal at Q_COMP. The coil voltage is processed through a blocking capacitor, voltage 

divider, and clamping diode to feed to the WLC1150 controller for Q-factor and resonance frequency 

estimation. 

8. Status indication – The firmware indicates the various system states or events using the dual-color (red 

and blue) status LED (LED1). See the Reference board operation to understand more details. 
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3.1.1 Board connectors 

The transmitter board has power and signal connectors for operating and monitoring the wireless power 

transfer. The function of each connector is listed in Figure 6. 

Table 2 REF_WLC_TX50W_N1 board connectors 

Connector Type Description 

J1 Power USB Type-C connector for DC input through a USB-C power adaptor or 

QC/AFC type AC/DC adaptor.* 

This connector is also used to download configuration data/firmware 

from the Wireless Configuration Utility through HPI dongle over the  

Type-C CC lines. For more information, see section 4.2.1. 

J3 Power Wire-to-board connector option for DC input through a variable DC power 

supply *  

J4 Power Jumper connection to power up the board either with USB PD or DC 

power supply.  

Jumper connection Pin 1-2 for PD adapter input. 

Jumper connection Pin 2-3 for DC power supply. 

J5 Signal Debug serial port. Connect to an HPI dongle (which is provided as part of 

the reference board package) to view system status on  PC using a 

terminal emulator software (Tera Term, Putty, and so on). The data is 

sent at a 1-M baud rate. 

J2 Signal SWD connector. This connector is used to monitor, log, and dynamically 

configure the firmware parameters from the Wireless Configuration 

Utility through an HPI dongle over I2C lines. For more information, see 

section 4.2.2. 

J8 Power A J8 connector is needed to connect with the fan connector. This 

connector is used to supply power to the fan. 

L3 Power Terminals for transmitter coil connection. 

* Do not power the transmitter board from both J1 and J3 simultaneously. 
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Figure 6 REF_WLC_TX50W_N1 power transmitter board power and signal connections 

3.1.2 Test points 

The test points in the REF_WLC_TX50W_N1 MP-A2 power transmitter board assist in monitoring and debugging 

the wireless power transfer system. The list of test points and their functionality is covered in Table 3. 

Table 3 List of test points on REF_WLC_TX50W_N1 

Test point name Section Description 

USB-IN Power Input power positive rail 

USB-GND Power Input power ground rail 

PVIN_0 Power – Buck/Inverter Input positive rail to buck converter and inverter 

FAN_VDDD Power – Buck  Buck stage output for Fan power supply 

SW1_0 Power – Buck  Buck stage switching node 

HG1_0 Signal – Buck  Buck stage high side MOSFET (Q3) gate signal 

LG1_0 Signal – Buck Buck stage low side MOSFET (Q3) gate signal 

VBB_1 Power – Inverter  Input inverter power after the current sense resistor  

COIL_SNS Power – Inverter Coil voltage; transmitter coil, and resonant capacitor 

junction point 

PWM_OUT Signal – Inverter  Inverter stage PWM signal 

PWM_IN1 Signal – Inverter PWM logic circuit O/P for inverter MOSFET Leg (Q4, Q5) 

PWM_IN2 Signal – Inverter PWM logic circuit O/P for inverter MOSFET Leg (Q6, Q7) 
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Test point name Section Description 

HG1_1 Signal – Inverter  Inverter bank 1 high side MOSFET (Q4) gate signal 

LG1_1 Signal – Inverter  Inverter bank 1 low side MOSFET (Q5) gate signal 

HG2_1 Signal – Inverter  Inverter bank 2 high side MOSFET (Q6) gate signal 

LG2_1 Signal – Inverter  Inverter bank 2 high side MOSFET (Q7) gate signal 

Q_COMP Signal – Q-factor Scaled coil voltage (for Q-factor measurement) 

ASK_OUT Signal – ASK demodulator ASK demodulator output from WLC1150 to amplification 

stage 

OPAMP_GAIN Signal – ASK demodulator ASK demodulator gain stage amplifier output 

CMP_REF Signal – ASK demodulator ASK demodulator comparator reference signal 

OPAMP_CMP Signal – ASK demodulator ASK demodulator comparator output; digital signal to 

WLC1150 

VIN Power – WLC1150 Power input to WLC1150 

VDDD Power – WLC1150 WLC1150 internal 5-V LDO output 

VCCD Power – WLC1150 WLC1150 internal 1.8 V core LDO output 

Q_COMP Signal – WLC1150 Signal used by WLC1150 for Q-factor estimation 

GND1, GND2 Power Power side ground points 

GND Signal Control side ground point 

Note: For more information, see the reference board’s schematic in the REF_WLC_TX50W_N1 release 

package. 
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4 Reference board operation 

This section explains the procedure to operate the REF_WLC_TX50W_N1 reference board. It also explains the 

procedure to configure the firmware in a static or dynamic manner and the procedure to download the 

configuration or firmware onto the WLC1150-68LQXQ controller. 

4.1 Wireless charging operation 

The firmware supporting power transfer using USB PD input power is pre-programmed at the time of shipment. 

The following procedure explains the steps required to do a power transfer using the USB PD input. 

4.1.1 Wireless power transfer using Infineon high power protocol mode 

(50W) 

1. Ensure that a jumper shunt is placed at positions 1 and 2 of the power mode selection jumper (J4) of the Tx 

reference board. 

2. Connect the USB Type-C power adapter provided as part of the REF_WLC_TX50W_N1 package to the USB 

Type-C connector (J1) of the Tx reference board. 

3. Confirm that the status LED (LED1) blinks five times in blue and red. Now the board is ready for use. 
 

 

Figure 7 Powering the WLC reference board  

4. Place the Infineon 50-W Rx board on the Tx interface of the Tx reference board as shown in Figure 8.  

5. Attach a load of up to 50W to the terminals of the Rx board. Ensure that the load is in the off state. The 

status LED (LED1) of the Tx board glows blue when the power transfer is in progress. 
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Figure 8 Wireless power transfer using high power protocol 

Note: Ensure that the DC load is connected to the Rx board as per the polarity marked on the Rx board. 

6. Increase the load in the maximum step of 20 W to exceed 40 W. Observe that the fan located on the bottom 

side of the Tx board turns on when the power transferred exceeds 40 W or when the Tx interface surface 

temperature sensed by the thermistor on the Tx board exceed 45°C to cool the temperature of the Tx 

interface surface. 

7. During the power transfer the load on the Rx board can be varied up to 50-W. However, the maximum step 

size for load change (application or removal) should not exceed 20-W.  

8. Remove the Infineon Rx board from the Tx interface surface of the Tx reference board. Observe that the 

status LED (LED1) turns off. 

9. Disconnect the USB Type-C power adapter once the high-power transfer operation is complete. 

Note: Avoid short circuits of the output load terminal of the Rx board. This may result in damage to the 

Rx board. 

4.1.2 Wireless power transfer using Qi protocol 

The following procedure explains the steps to charging using the Qi protocol. 

1. Repeat steps 1 to 3 of section 4.1.1 to exercise the power up the transmitter board. 

2. Place the Qi phone/receiver on the Tx interface surface of the Tx reference board as shown in Figure 9. 

3. The status LED (LED1) of the Tx board glows blue when the power transfer is in progress. 

4. Observe that the status LED turns OFF when the phone/receiver is removed from the Tx interface surface or 

once the phone is fully charged (100%). 

5. Disconnect the USB Type-C power adapter once the power transfer operation is complete. 

Note: The status LED continues to glow blue if the phone remains in trickle charging mode after the 

battery is fully charged. 
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Figure 9 Powering the WLC reference board for Qi Rx/Phone 

4.1.3 System Status and Status LED indication 

Table 4 describes the status LED indications for various system states. 

Table 4 System states and status LED indications 

Note: The REF_WLC_TX50W_N1 reference board with factory default firmware may exhibit timeout-

bound retry of Qi power contract under extremely noisy ASK modulated signal conditions with a 

few phones/receivers. Such behavior does not affect wireless charging performance. See the 

REF_WLC_TX50W_N1 reference board’s test report for more details about the phone charging 

cycle, ASK demodulation, and Qi 1.3.2 compliance test results. Download this report from the 

REF_WLC_TX50W_N1 reference board webpage [1]. 

System state Status LED indication 

Idle state No LED indication 

Digital ping phase Blinks blue 

Power delivery in progress Glows blue 

Power Delivery/charge complete No LED indication 

Foreign object (FO) detected Glows red until FO is removed 

Fault during power transfer Blinks red until the fault is cleared 

Abrupt end of power transfer (EPT) initiated by the 

receiver 

Blinks red 
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4.1.4 Troubleshooting 

See Table 5 for troubleshooting the potential issues faced while operating the WLC 50 W Tx reference board. 

Table 5 Troubleshooting of the WLC 50W Tx reference board operation 

# Issue Possible cause Fix 

1 The power transfer between 

the transmitter and receiver 

stops soon after it begins and 

the status LED (LED1) glows 

red. 

There might be a foreign 

object (FO) present on the 

interface surface 

Remove the receiver from the interface 

surface and verify for any FO presence 

and retry placing the receiver on the 

interface surface. 

2 The receiver reference board 

REF_WLC_RX50W_N1 does 

not provide output power 

and debug logs show EPT121. 

The receiver has 

terminated the power 

transfer because of a 

potential fault in the 

receiver 

Power recycle the transmitter and retry. 

In case the issue persists, contact 

Infineon technical support. 

3 The phone is not charging 

when placed on the interface 

surface of the WLC reference 

board. 

The phone may not be a 

Qi-compliant phone. 

Check with the phone manufacturer on 

Qi compatibility. Get a Qi-compliant 

phone. 

4 The phone is charging at a 

slow rate. 

The phone may not 

support Qi EPP capability. 

Check with the phone manufacturer on 

support for EPP capability. Get a phone 

which can support EPP to charge at  

15 W. 

5 During high power transfer ( > 

15W), there is a momentary 

power reset during start of 

the power transfer at the load 

side on the receiver 

(REF_WLC_RX_50W_N1). 

The transmitter 

(REF_WLC_TX_50W_N1) 

may have observed higher 

power loss compared to 

the estimated loss. So, the 

transmitter shall check the 

possibility of FO presence  

by measuring the Q-factor. 

If no FO is detected, the 

transmitter enters the 

power delivery mode, 

calibrates for high power 

loss, and proceeds with 

charging. This process is 

repeated every time the 

receiver is placed on the 

charging area.  

Ensure that no FO is present on the 

charging surface of the transmitter 

 

Ensure the receiver is well-aligned on 

the transmitter’s charging surface and 

try again. If the issue is persistent, 

calibrate the system for power loss FOD 

(Foreign Object Detection). Follow the 

instructions given in Appendix B: 

Procedure to do calibration for power 

loss FOD to complete the power loss 

FOD calibration. 

 

Note: By default, the REF_WLC_TX50W_N1 reference board is loaded with firmware that supports  

USB PD-based power input. However, the reference board can be used for wireless power transfer 

with high power protocol (50 W) using a DC supply, requiring a different firmware. See Appendix A 

to understand the procedure for Wireless power transfer by using High power protocol (50 W) 

mode with a DC input power supply. 

https://www.infineon.com/cms/en/about-infineon/company/contacts/support/


  

User guide 19 002-36393 Rev. *C 

  2023-04-19 

 

  

 

WLC1150 MP-A2 50-W wireless power transmitter 

(REF_WLC_TX50W_N1) user guide 
Reference board operation  

 

4.2 Firmware download, configuration (static/dynamic), and 

monitoring/debugging 

WLC1150 IC is a programmable controller, which supports downloading the updated/modified configuration 

data and downloading the firmware. It also supports monitoring the firmware parameters and dynamic tuning 

of the firmware parameters. The WLC1150 controller supports these features through CC and/or I2C interfaces 

based on the input power type supported in the current firmware, which is stored in the flash. See Table 6 to 

understand the communication interface (CC/I2C) to use based on the current firmware type. 

Table 6 Communication interface (CC/I2C) to use for firmware download and configuration 

Scenario #  Input power type 

supported by the current 

firmware stored in flash 

Communication 

interface for 

downloading firmware/ 

configuration data 

Communication interface for 

monitoring firmware parameters 

and dynamically configuring them 

1 USB PD CC /I2C I2C 

2 DC I2C 

4.2.1 USB CC communication-based set-up 

Figure 10 describes the set-up to download configuration data or firmware over the USB CC interface of the 

WLC1150 controller. 
 

 

Figure 10 USB CC communication-based setup 

Execute the following procedure to create the setup: 

1. Ensure that a jumper shunt is placed at positions 1 and 2 of the power mode selection jumper (J4) of the Tx 

reference board. 

2. Connect the HPI dongle to the Tx reference board using the USB Type-C cable. 

3. Connect the HPI dongle to the PC using a USB micro-B cable. 

4. The Power LED (LED1) on the HPI dongle glows blue, and the status LED (LED1) on the WLC1150 reference 

board blinks in blue and red five times. 

5. Open the Wireless Charging Configuration Utility from the Start menu in Windows. 

6. Confirm that the reference board is selected under the Device Selection tab, as shown in Figure 11. 
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Figure 11 Selecting WLC1150 device in Wireless Charging Configuration Utility 

 

7. Go to Tools > Firmware Update or select the Firmware Update option from the Home panel. Specify the 

path for the firmware as shown in Figure 12 and click Program. 
 

 

Figure 12 Selecting firmware for download 
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8. Wait for the firmware download to complete, as shown in Figure 13. This operation may take around one 

minute. 
 

 

Figure 13 Downloading firmware to WLC1150 controller 

9. Dismantle the hardware connection between HPI Dongle, PC, and Tx reference board. 
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4.2.2 I2C communication-based setup 

Figure 14 describes the setup to download firmware/configuration or monitor firmware parameters or 

dynamically tune the firmware parameters over the I2C interface of the WLC1150 controller. 

 

Figure 14 I2C communication-based setup 

Execute the following procedure to create the setup: 

1. Establish an I2C connection between the WLC1150 reference board and the HPI dongle by connecting the 

three jumper wires. 

a) Connect a jumper wire between the SCL pin of the HPI dongle (pin no. 5 of the J2 header) and the 

HPI_I2C_SCL pin of the WLC1150 reference board (pin no. 4 of the J2 header). 

b) Connect a jumper wire between the SDA pin of the HPI dongle (pin no. 6 of the J2 header) and the 

HPI_I2C_SDA pin of the WLC1150 reference board (pin no. 5 of the J2 header). 

c) Connect a jumper wire between the GND pin of the HPI dongle (pin no. 3 of the J2 header) and the GND 

pin of the WLC1150 reference board (pin no. 2 of the J2 header). 

2. Ensure that a jumper shunt is placed at positions 1 and 2 of the power mode selection jumper (J4) of the Tx 

reference board 

3. Connect the HPI dongle to the PC using a USB micro-B cable. 

4. The Power LED (LED1) on the HPI dongle glows blue. 

5. Connect the 65 W USB Type-C power adapter to the Tx reference board using the USB Type-C cable. The 

status LED (LED1) on the WLC1150 reference board blinks in blue and red five times. 

6. Now the setup is ready for use by the Wireless Charging Configuration Utility. 

7. See the Wireless Charging Utility user guide to understand the procedure to monitor firmware parameters, 

dynamically tune the firmware parameters, and download firmware/configuration data/monitor and 

dubbing. The utility user guide can be accessed from the Help menu of the utility. 

8. Dismantle the hardware connection between the HPI dongle, PC, and Tx reference board. 
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4.3 Capturing debug logs on the WLC reference board 

This section explains the procedure to capture the debug logs sent on the serial port of the 

REF_WLC_TX50W_N1 reference board at various stages of the operation. This feature helps to understand the 

internal operation of the firmware in addition to the status LED indication available on the board. 

To capture the debug log, follow these steps: 

1. Install data logging software on the PC. 

a) Download a data logging tool, such as Tera Term, and install it on the PC. 

2. Enable the debug log in the firmware. 

a) Download the Wireless Charging Utility package from the REF_WLC_TX50W_N1 release package and 

install it on the PC. 

b) Create the USB CC communication-based (Figure 10) or I2C communication-based (Figure 14) hardware 

set-up to configure the firmware using Wireless Charging Configuration Utility. 

c) Open the Wireless Charging Configuration Utility from the Start menu in Windows. 

d) Confirm that the reference board is selected under the Device Selection tab, as shown in Figure 15. 
 

 

Figure 15 Selective device in Wireless Charging Configuration Utility 

e) Click Tools > Read from Device or select the Read from Device option from the Home panel. This 

enables the user to read the configuration from the device. 

f) The debug log can be enabled by configuring the following parameters in the transmitter Profile page in 

the Wireless Charging Configuration Utility, see Figure 16. 

o Enable Critical log enable 

o Enable Message log enable 

o Set Debug log to Level 1 
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Figure 16 Profile page settings for enabling debug log 

g) Select the device in the Device Selection tab and select Tools > Configure Device or click on the 

Configure device icon present in the Home panel. Save the updated configuration to a file. 

h) In the Configure Device dialog box, specify the path of the updated configuration file and click Program, 

as shown in Figure 17. 
 

 

Figure 17 Device configuration dialog 

i) Wait until the updated configuration file gets downloaded, as shown in Figure 18. 
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Figure 18 Successful download of configuration file 

j) Dismantle the hardware setup. 
 

3. Debug log capture setup. 

a) Do the following connections using jumper wires to establish a serial connection between the 

REF_WLC_TX50W_N1 board and the HPI dongle: 

o Connect a jumper wire between the UART_Tx pin of J5 of the REF_WLC_TX50W_N1 board and 

the Rx pin of the J2 header on the HPI dongle board. 

o Connect a jumper wire between the GND pin of J5 of the REF_WLC_TX50W_N1 board and the 

GND pin of the J2 header on the HPI dongle board. 

b) Connect REF_WLC_TX50W_N1, HPI dongle, and PC as shown in Figure 19. 
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Figure 19 Setup for capturing debug log 

4. Capture debug logs. 

a) Open the Tera Term on the Windows PC and select the virtual serial port listed on the Tera Term tool. 

b) Set the baud rate to 1000000. Set the remaining settings as default, as shown in Figure 20. 
 

 

Figure 20 Tera Term settings 

c) Supply power to the REF_WLC_TX50W_N1 board using the USB-C power adapter and recreate the usage 

condition during which the debug logs need to be captured. Displays the log data on the Tera Term as 

shown in Figure 21. 
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Figure 21 Debug log output 

d) Save the log into a file from Tera Term. 

e) Contact Infineon technical support with the captured log files if additional support is required. 

Note: If the temperature around the NTC goes below 25°C, it is not required to monitor as the transmitter is 

working in a safe operating region. Therefore, the debug log shows the value of NTC TEMP as 25°C until 

the temperature around the NTC does not exceed 25°C. 

5. Disable debug log in the firmware. 

Revert these changes in firmware to default on completion of the process. The debug log consumes the 

processor resource, and it is recommended to disable the debug log for optimal performance of the WLC power 

transmitter.  

 

 

 

 

https://www.infineon.com/cms/en/about-infineon/company/contacts/support/
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5 Appendix A: Wireless power transfer by using high power 

protocol (50W) mode with DC input power supply 

This section explains the procedure to enable DC input power-based wireless charging operation for high 

power protocol (50W) mode. 

Do the following procedure to update the reference board and download the firmware which supports DC input 

power-based operation, and exercise the wireless charging operation for high power protocol (50W) mode: 

1. Identify the firmware intended for the DC power supply from the README file in the REF_WLC_TX50W_N1 

release package. 

2. Download the firmware using the procedure mentioned in section 4.2. 

3. Install the jumper shunt at positions 2 and 3 of the power mode selection jumper (J4) of the Tx reference 

board. 

4. Connect the DC supply to the DC input connector (J1) of the Tx reference board. Ensure that the DC input is 

connected according to the polarity marked on the Tx reference board. 

5. Confirm that the status LED (LED1) blinks five times in blue and red. Now the board is ready for use. 

6. Repeat Steps 4 to 7 of section 4.1.1 to exercise 50 W power transfer capability. 

7. Disconnect the DC supply once the high-power transfer operation is complete. 
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6 Appendix B: Procedure to do calibration for power loss FOD  

This section explains the calibration procedure  for power loss FOD. 

1. Connect the device over the I2C interface and power up the device using the Type C power adapter. Place 

the jumper for the J4 connector between Pin1 and Pin2 (see Figure 22). 

 

 
Figure 22 I2C interface connection set up 

2. Open the Wireless Charging Configuration utility and select the device (WLC-I2C-1) from the device 

selection tab (see Figure 23). 

 

 

Figure 23 Invoking Wireless Charing Configuration utility  
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3 Go to Tools > Option, and check the box for “Enable advanced configuration parameters” and click 

Save (see Figure 24). 

 

Figure 24 Enabling advanced configuration parameters  

4 Click on the “Read from device” icon, select FOD Power Loss, and disable the power loss FOD by 

selecting Disable under the drop-down menu (refer to Figure 25). 

 Figure 25 Disabling power loss FOD 
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5. Go to Tools and select “Configure Device” (refer to Figure 26). 

 

Figure 26 Selecting configure device  

6. A pop-up window will appear prompting you to save the configuration. Select “Yes” and save the file with an 

appropriate name, such as “FOD Disable” (refer to Figure 27). 

 

Figure 27 Disabling the FOD 
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7. After saving the configuration file, the “Configure device” dialog box pops up. Click on “Program”.  After the 

program completion, the message “Flash updated successfully” is displayed. 

 

Figure 28 Saving the configuration setting 

8. Place the receiver on the transmitter coil interface at a well-aligned position. Do not move the receiver 

during the entire calibration process. Connect the electronic load (minimum of 24V and 3A rated) to the 

receiver load connector terminal. Ensure that the receiver board has powered-up which is indicated by the 

status LED that glows blue (refer to Figure 29). 

 

 
Figure 29 Set up for power loss calibration 
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9. Go to the “System Loss Calibration” tab and select the “High power proprietary protocol calibration” from 

the “Test power receiver type” drop-down menu (refer to Figure 30).  

 

Figure 30 Selecting power loss calibration 

10. Select load (%) from the drop-down menu list (2% to 102%) under “Select load”. Load the receiver by 

electronic load with the same % of load of 50W (that is, 2% of 50W is equal to 1W). After  10sec, when the 

load stabilizes, click on “Start Calibration” on the top right corner.  

A power loss calibration table publishes the transmitter power and receiver power after calibration against 

each load. Therefore, ensure that the same is published before moving to the next load (%) (see Figure 31). 

 

Figure 31 Starting the power loss calibration  



 

User guide 34 002-36393 Rev. *C 

  2023-04-19 

 

  

 

WLC1150 MP-A2 50-W wireless power transmitter 

(REF_WLC_TX50W_N1) user guide 
Appendix B: Procedure to do calibration for power loss FOD  

11. Repeat step 10 till 102% of the load is reached (refer to Figure 32). 

 

Figure 32 Specifying power loss calibration values 

12. Click on “Calculate coefficients” tab. Coefficient A, B, and C are published in the screen. Copy the same in 

your local file in a notepad (refer to Figure 33) . 

 

Figure 33 Calculating power loss co-efficient values 
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13. Close the System loss calibration window and click on the “Read from device” icon, select “FOD Power 

Loss”, and enable the FOD (refer to Figure 34).  

 

 

Figure 34 Selecting FOD power loss calibration 

14. Change the FOD coefficients a, b, and c with new calibrated coefficients (refer to Figure 35) 

 

Figure 35 Specifying new power loss calibration coefficients 
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15. Go to the “File” tab and select the “Save to firmware file” option (refer to Figure 36).  

This  allows the user to save the file in either  “.CYACD2” or “.hex”* extension format.  Select the “.CYACD2” 

extension and save the file. 

Note: The I2C-based connection does not support the “.hex” extension file. If you  save the file in the .hex 

format, it can be programmed by using MiniProg4. 

 Figure 36 Saving the firmware with new calibration coefficients 

16. Click on the “Firmware update” icon and program the updated file (.CYACD2) (refer to Figure 37). Wait for 

the “Flash uploaded successfully” pop-up window. 

 

Figure 37 Programming the firmware with updated calibration coefficients 

This completes the calibration procedure for power loss FOD on the REF_WLC_TX50W_N1 board.
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